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ВВЕДЕНИЕ 

 

Возникновение метода конечных элементов (МКЭ) связано с задачами 

космических исследований. Важный вклад в теоретическую разработку метода 

внес в 1963 году Мелош, который показал, что МКЭ можно рассматривать как 

один из вариантов хорошо известного метода Рэлея-Ритца. Область применения 

метода значительно расширилась, когда было получено, что уравнения, 

определяющие элементы в задачах строительной механики, распространения 

тепла, гидромеханики, могут быть легко получены с помощью таких вариантов 

метода взвешенных невязок, как метод Галеркина или способ наименьших 

квадратов. Метод Галёркина (метод Бубнова–Галёркина) – метод 

приближённого решения краевой задачи для дифференциального уравнения 

был разработан Галеркиным в 1915 году. Применение этого метода позволяет 

исключить необходимость вариационной формулировки физической задачи, 

что позволило применять метод конечных элементов при решении любых 

дифференциальных уравнений. 

Основная идея МКЭ [2, 3] состоит в том, что любую непрерывную 

величину, такую, как температура, давление или перемещение, можно 

аппроксимировать дискретной моделью, которая строится на множестве 

кусочно-непрерывных функций, определенных на конечном числе подобластей. 

Кусочно-непрерывные функции определяются с помощью значений 

непрерывной величины в конечном числе точек рассматриваемой области. В 

общем случае непрерывная величина заранее неизвестна и нужно определить 

значения этой величины в некоторых внутренних точках области. Дискретную 

модель, однако, очень легко построить, если сначала предположить, что 

числовые значения этой величины в каждой внутренней точке области 

известны. После этого можно перейти к общему случаю. Итак, при построении 

дискретной модели непрерывной величины поступают следующим образом. 

1. В рассматриваемой области фиксируется конечное число точек. Эти 

точки называются узловыми точками или просто узлами. 
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2. Значение непрерывной величины в каждой узловой точке считается 

переменной, которая должна быть определена. 

3. Область определения непрерывной величины разбивается на конечное 

число подобластей, называемых элементами. Эти элементы имеют 

общие узловые точки и в совокупности аппроксимируют форму 

области. 

4. Непрерывная величина аппроксимируется на каждом элементе 

полиномом, который определяется с помощью узловых значений этой 

величины. Для каждого элемента определяется свой полином, но 

полиномы подбираются таким образом, чтобы сохранялась 

непрерывность величины вдоль границ элемента.  

Основным преимуществом МКЭ перед другими методами решения 

дифференциальных уравнений является его универсальность. Она состоит в 

том, что этим методом можно решать любые дифференциальные уравнения, с 

любыми краевыми условиями в областях любой геометрии и сложности. 

Например, один раз реализовав метод для выбранной системы уравнений, 

решаемых в какой-то области, при изменении краевых условий или геометрии 

области не требуется менять что-либо в реализации метода, а треугольная (в 

плоском случае) и тетраэдрическая (в трехмерном случае) вычислительная 

сетка позволит дискретизировать область любой формы с нужной точностью. 

Универсальность метода также подтверждается его использованием в 

современных конечно-элементных программах таких, как ANSYS [1, 4], Comsol 

multiphisics, ABAQUS, ADINA, Nastran, Лира и др. 

Основной проблемой метода является высокая размерность 

результирующей системы алгебраических уравнений. Поэтому реализация 

МКЭ в составе САПР требует разработки специальных способов хранения 

матрицы коэффициентов системы и методов решения последней. Все же для 

решения задач больших размерностей приходится использовать мощную 

вычислительную технику. Для таких расчетов компьютеры объединяют в так 

называемые вычислительные кластеры. Вычислительные кластеры позволяют 
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уменьшить время расчетов, по сравнению с одиночным компьютером, разбивая 

задание на параллельно выполняющиеся ветки, которые обмениваются 

данными по связывающей сети. 

Подробнее остановимся на моделировании в конечно-элементном 

комплексе ANSYS Mechanical APDL. Рассмотрим некоторые аспекты 

геометрического моделирования и создания регулярных вычислительных сеток. 

Далее приведем примеры решения задач в ANSYS Mechanical APDL: задачи о 

течении жидкости в плоских каналах, артериях, задача о нагружении левого 

желудочка сердца давлением. 
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1. РАБОТА В ANSYS Mechanical APDL 
 

Запуск ANSYS Mechanical APDL 

 

Запуск программы ANSYS Mechanical APDL осуществляется либо через 

Ansys product launcher с заданием дополнительных настроек, либо через ярлык 

ANSYS без задания дополнительных настроек. Рассмотрим первый вариант 

запуска программы 

– выбираем наименование модуля (ANSYS), тип лицензии (ANSYS 

Academic Research) 

– далее задаем параметры в следующих вкладках  

File management (указываем рабочую папку и имя файла);  

Customization preferences (задаем количество выделяемой памяти, тип 

графического отображения и язык интерфейса; 

High performance computing setup (задаем количество ядер для 

осуществления расчета, компьютеры для распределенных вычислений). 

 

Обзор пунктов меню над рабочей областью графического интерфейса 

 

– File (работа с файлами, именами, директориями, экспорт/импорт 

геометрии, чтение модели из файла); 

– Select (работа с геометрией, выбор, скрытие определенных 

геометрических объектов, а также создание компонент и их объединений); 

– List (табличный вывод списка геометрических объектов и объектов 

сетки, выбор и отображение атрибутов геометрических объектов и объектов 

сетки); 

– Plot (отображение различных объектов, рисование графиков созданных 

функций и т.п.); 

– PlotCtrls (настройки отображения, шрифтов, работа с анимацией, 

сохранение изображений, видео в файл и т.п.); 

– Workplane (операции с рабочей плоскостью и системами координат); 
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– Parameters (операции с параметрами – таблицами и функциями); 

– Macro (создание и выполнение макросов); 

– MenuCtrls (настройки меню); 

– Help (раздел помощи). 

Под основным меню имеется текстовое поле для ввода команд. Не все 

команды в ANSYS Mechanical APDL реализованы в графическом интерфейсе, 

поэтому при постановке, решении и анализе задач требуется вводить некоторые 

команды вручную.  

 

Меню слева от рабочей области 

 

Preferences (выбор основного решающего модуля); 

Preprocessor (меню постановки задачи); 

Подменю 

Element Type (выбор типа элемента = выбор уравнений, описывающих 

моделируемый процесс); 

Real Constants (задание некоторых характеристик элементов, например, 

для плоского элемента задание его толщины); 

Material Properties (выбор материала и задание его свойств); 

Sections (задание поперечных сечений для некоторых элементов, 

например, для балок); 

Modeling (меню создания, редактирования геометрии модели); 

Meshing (создание и редактирование вычислительной сетки); 

Checking Ctrls (меню проверки качества созданной модели); 

Numbering Ctrls (работа с геометрией, сеткой, слияние одинаковых 

объектов); 

Archive Model (создание архива модели); 

FLOTRAN Set-up (меню настройки решателя Flotran вычислительной 

гидродинамики); 
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Multi-field Set-up (меню постановки мультифизичных задач, например, 

связанной упруго-гидродинамической задачи); 

Loads (меню задания, редактирования и удаления нагрузок – граничных и 

начальных условий); 

Path Operations (меню создания, редактирования так называемых путей–

маршрутов); 

Solution (меню решения задачи); 

Подменю 

Analysis Type (выбор типа анализа: стационарный, нестационарный, 

модальный, гармонический, спектральный и т.д.); 

Define Loads (меню задания, редактирования и удаления нагрузок – 

граничных и начальных условий); 

Load Step OPTS (меню настроек шагов нагружения); 

Solve (меню запуска решателя); 

General Postprocessor (общий постпроцессор – обработка и вывод результатов 

расчета); 

подменю 

Data and File OPTS (выбор файла с результатами); 

Results Summary (вывод информации о кол-ве шагов/итераций в файле 

результатов); 

Read Results (чтение шагов/итераций из файла); 

Plot Results (отображение прочитанных результатов: в виде изображения 

поля значений величины цветом на геометрии модели, векторного поля 

значений векторной величины, начальной и измененной геометрии модели, 

линий тока, отображение графика изменения значений выбранной величины по 

созданному пути-маршруту и т.д.); 

List Results (вывод результатов – значений величин в виде списка); 

Results Viewer (оболочка, в которой объединены основные средства для 

обработки результатов расчета); 
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Path Operations (меню работы с путями-маршрутами: создание, 

редактирование маршрута, помещение на маршрут переменной и т.д.). 

Surface Operations (меню работы с поверхностями/сечениями: создание 

сечения, редактирование, помещение переменной на сечение и т.д.). 

Timehistory Postprocessor (вывод и обработка результатов решения 

нестационарных расчетов). 

В ANSYS Mechanical APDL некоторые пункты меню дублируются, 

поэтому нагрузки можно задавать и в Preprocessor (Loads), и в Solution (Define 

loads), что не сказывается на результате расчетов. Также продублирован пункт 

FLOTRAN Set Up в меню Preprocessor и в Solution. 

Здесь описаны не все меню, присутствующие в ANSYS Mechanical APDL. 

Мы сознательно не стали их описывать по причине того, что они не будут в 

дальнейшем требоваться при обработке результатов расчетов, приведенных в 

данном пособии.  
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2. СОЗДАНИЕ ГЕОМЕТРИЧЕСКИХ ОБЪЕКТОВ 

 

Геометрическое моделирование можно проводить тремя способами. 

1. Моделирование снизу-вверх, то есть сначала создаются точки, потом линии, 

затем поверхности/плоскости и объемы. 

2. Моделирование с помощью геометрических примитивов – круги, 

прямоугольники, цилиндры, конусы, параллелепипеды и т.п. 

3. Смешанный способ – используется как метод моделирования снизу-вверх, 

так и моделирование с помощью геометрических примитивов. 

Мы будем пользоваться смешанным способом моделирования, работая с 

геометрическим объектами как с множествами. Последнее означает, что при 

таком подходе все операции, доступные для работы с множествами, могут 

использоваться и для геометрических объектов. Например, можно объединять, 

пересекать, вычитать геометрические объекты. Перейдем к описанию 

моделирования геометрических объектов в ANSYS Mechanical APDL. 

1. Точки можно создавать с помощью задания координат в активной 

системе координат (In active CS), на рабочей плоскости (On working plane), на 

линии (указывая точно в долях единицы от всей длины расстояние до ее конца 

или указывая мышью местоположение точки On line w/ratio, on line), между 

точками (KP between KPs), на узле (On node) и т.д. 

2. Существует несколько способов создания линий  

• линия – прямая линия (Straight line), касательная к линии (Tangent to line), 

касательная к двум линиям (Tangent to 2 lines), линия в плоскости (On area), 

перпендикулярно линии (Normal to line), перпендикулярно двум линиям 

(Normal to 2 lines), под углом к линии (At angle to line), под углами к двум 

линиями (At angle to 2 lines); 

• дуги – через три точки (Through 3 KPs), через центр и радиус, окружность 

(By cent and radius), через конечные точки и радиус (By end KPs and radius), 

полная окружность (Full circle); 
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• сплайны – сплайн через точки (Spline thru KPs), сегментированный сплайн 

(Segmented spline); 

• сглаживающая линия (Line fillet) – гладко соединяет две пересекающиеся 

линии. При этом задаются две пересекающиеся линии и радиус скругления. 

3. В ANSYS Mechanical APDL имеется несколько способов создания 

поверхностей – создание посредством указания точек (Through KPs), линий (By 

lines) и т.д.; создание прямоугольников (Rectangle: by 2 corners, by dimensions, 

by cent and corners); создание кругов и их частей (Solid circle, partial annulus, 

annulus); создание многоугольников (triangle, square, pentagon, hexagon etc.); 

создание сглаживающей поверхности (area fillet). 

4. Также имеется несколько способов создания объемов – с помощью 

точек (Through KPs), поверхностей (By areas); создание параллелепипедов 

(Block: by 2 corners and Z, by cent, corners and Z, by dimensions), сфер (Sphere), 

цилиндров (Cylinder: solid, hollow, partial, by end points and Z, by dimensions), 

призм (prism: triangulat, square, pentagonal etc.), сфер (sphere: solid, hollow, by 

end points, by dimensions), конусов (cone: by picking, by dimensions) и тора 

(torus). 

В состав ANSYS Mechanical APDL входит достаточно мощный редактор 

созданных геометрических объектов: булевы операции (пересечение, 

объединение, вычитание, склеивание, разделение), операции масштабирования, 

перемещения, копирования, отражения, удаления.  

Одним из отличий ANSYS Mechanical APDL от подобных программных 

продуктов является отсутствие операции отмены действий, поэтому 

выполненные операции не могут быть отменены, а созданные объекты – только 

удалены.  

Перемещение объектов по рабочей области осуществляется с помощью 

мыши при нажатой левой кнопке и клавиши ctrl, поворот осуществляется с 

помощью мыши с нажатой правой кнопкой и клавишей ctrl.  

Объекты создаются левой кнопкой мыши, если стрелка указателя мыши 

направлена вверх. Удаление неподтвержденного объекта осуществляется левой 
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кнопкой мыши, если стрелка указателя направлена вниз. Переключение между 

режимами создания/удаления объектов производится нажатием правой кнопкой 

мыши. Подтверждение выполнения операций (например, создание 

геометрических объектов, вычислительной сетки) осуществляется либо 

нажатием средней кнопкой мыши, либо кнопкой Apply контекстного меню 

выполняемой операции.  

Приведем пример построения и редактирования геометрических объектов 

средствами ANSYS Mechanical APDL. 
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Пример создания геометрического объекта 

 

Построим на рабочей плоскости несколько точек Preprocessor->Modeling-

>Create->Keypoints->On working plane (левой кнопкой наносим точки на 

плоскость, средней кнопкой мыши подтверждаем создание всех точек) (рис. 

2.1). 

 

Рис. 2.1. Построение точек на рабочей плоскости 

 

Далее создадим прямые линии с использованием созданных точек 

Preprocessor->Modeling->Create->Lines->Lines->Strait line. 

Выбираем по две точки – начало и конец линии, подтверждаем создание 

линии средней кнопкой мыши (рис. 2.2).  

Важно отметить, что ANSYS Mechanical APDL выводит подсказки 

пользователю в левом нижнем углу под рабочей областью, что существенно 

упрощает работу и позволяет в любой момент при выполнении какой-либо 

операции знать, что программа требует от пользователя.  
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Рис. 2.2. Создание линий 

 

Создадим на базе имеющихся линий две поверхности Preprocessor-

>Modeling->Create->Areas->Arbitrary->By lines (выбираем линии, 

ограничивающие будущие поверхности, и средней кнопкой мыши 

подтверждаем создание каждой поверхности). 

Отобразим созданные поверхности Plot->Areas (рис. 2.3). 

 

Рис. 2.3. Создание поверхностей 
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Отобразим каждую поверхность своим цветом PlotCtrls->Numbering-

>AREA area numbers (on), Numbers shown with (Colors only) (рис. 2.4).  

 

Рис. 2.4. Присвоение цвета поверхностям 

 

Получаем следующую картинку. 

 

Рис. 2.5. Визуализация поверхностей 

 

Объединим созданные поверхности в одну с помощью булевой операции 

Add (объединение или логическое сложение) Preprocessor->Modeling->Operate-



 17 

>Booleans->Add->Areas. Выбираем две поверхности и подтверждаем выбор 

средней кнопкой мыши (рис. 2.6). 

 

Рис. 2.6. Объединенные поверхности 

 

Разобьем получившуюся поверхность на две с помощью линии. Для этого 

сначала создадим линию по точкам Preprocessor->Modeling-> Create->Lines-

>Lines->Strait line. Далее Preprocessor->Modeling->Operate->Booleans->Divide-

>Area by line (выбираем поверхность, подтверждаем выбор средней кнопкой 

мыши, затем выбираем линию и также подтверждаем ее выбор средней 

кнопкой мыши) (рис. 2.7). 

 

Рис. 2.7. Разделение поверхности 
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Удалим нижнюю поверхность, обозначенную фиолетовым цветом 

Preprocessor->Modeling->Delete-> Area and below (удаляем поверхность и все, 

что ниже поверхности по уровню, то есть линии и точки, из которых она 

состоит) (рис. 2.8). 

 
Рис. 2.8. Удаление поверхности 

 

Создадим новую поверхность таким образом, чтобы она полностью 

помещалась в получившийся треугольник. Для этого сначала создадим точки на 

рабочей плоскости, а затем прямые линии через эти точки Preprocessor-

>Modeling->Create->Lines->Lines->strait line. Получим новую поверхность, 

при этом отобразим линии Plot->Lines (рис. 2.9). 

 
Рис. 2.9. Отображенные линии 
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Затем создадим по получившимся линиям четырехугольник 

(Preprocessor->Modeling->Create->Areas->Arbitrary->By lines), отобразим при 

этом поверхности Plot->Areas (рис. 2.10). 

 
Рис. 2.10. Новые поверхности 

 

Вычтем четырехугольник из треугольника (булева операция вычитания 

Subtract) Preprocessor->Modeling->Operate->Booleans->Subtract->Areas 

(выбираем сначала уменьшаемую поверхность, подтверждаем выбор средней 

кнопкой мыши, затем вычитаемую поверхность и также подтверждаем выбор 

средней кнопкой мыши) (рис. 2.11).  

 
Рис. 2.11. Поверхность после вычитания 
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После каждого выполняемого действия с объектами желательно 

перерисовывать объекты (щелкаем правой кнопкой по рабочей области, 

выбираем в контекстном меню пункт replot или меню Plot->Replot). 

 

Задания для самостоятельной работы 

 

1. Создать следующий геометрический объект (используя примитивы 

прямоугольник, круг, вычитание геометрических объектов). 

 
2. Создать следующие поверхности (использовать булеву операцию 

разбиение поверхности линиями). 
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3. Построить следующую модель канала (длина 15 см, ширина на входе 1 

см, на выходе 2 см, расстояние от входа до расширения канала 6 см.). 

Использовать геометрический примитив прямоугольник (rectangle->by 

2 corners или by dimensions). Для возможности в дальнейшем 

корректно ставить граничные условия требуется разбить нижнюю 

границу верхнего прямоугольника левой вертикальной границей 

нижнего прямоугольника на две линии (Preprocessor->Modeling-

>Operate->Booleans->Divide->Line by line). Размеры следует из 

сантиметров перевести в метры. 

 

4. Построить следующую модель канала (длина 30 см, ширина на входе 1 

см, на выходе 2 см, расстояние от входа до расширения канала 6 см.). 

Использовать геометрический примитив прямоугольник (rectangle->by 

2 corners или by dimensions). Для возможности в дальнейшем 

корректно ставить граничные условия требуется разбить нижнюю 

границу верхнего прямоугольника левой вертикальной границей 

нижнего прямоугольника на две линии. Размеры следует из 

сантиметров перевести в метры. 
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5. Построить следующий кронштейн (использовать геометрические 

примитивы прямоугольник, круг; скругление справа вверху сделать с 

помощью create->lines->line fillet; булевы операции сложения, 

вычитания, объединения и деления области с помощью линии). 

Размеры выбрать произвольные. 
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3. РАБОЧАЯ ПЛОСКОСТЬ, СПЛАЙНЫ, ВЫТЯГИВАНИЕ         

ПО ТРАЕКТОРИИ 

 

Построим следующую модель извитого сосуда [6, 7], изображенную на 

рисунке 3.1. 

 
Рис. 3.1. Модель извитого сосуда 

 

Для этого сначала построим несколько точек, через которые проведем 

сплайн. Будем задавать их координаты в активной системе координат 

(Preprocessor->Modeling->Create->Keypoints->In active CS): 

( )00.0;00.0  

( )00.0;05.0  

( )03.0;10.0  

( )00.0;15.0  

( )02.0;20.0  

( )00.0;25.0  

Далее проводим через созданные точки сплайн: Preprocessor->Modeling-

>Create->Lines->Splines->Spline thru keypoints. 

Для создания полукруга в начальной точке построенной кривой поместим 

в эту точку рабочую плоскость перпендикулярно кривой Workplane->Align WP 

with->Plane normal to line, далее выбираем кривую, средней кнопкой мыши 
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подтверждаем выбор и в меню вводим значение от 0 до 1, которое определит 

положение рабочей плоскости на кривой (0 – начало кривой, 1 – конец, 0.5 – 

середина кривой). В данном случае следует ввести значение 0. Получаем 

рисунок 3.2. 

 
Рис. 3.2. Построение сплайна 

 

Построим сечение полукруга в рабочей плоскости. Для этого 

воспользуемся следующим инструментом создания сектора Preprocessor-

>Modeling->Create->Areas->Circle->Partial annulus. В появившемся окне 

задаем значения Rad_2=0.005, Theta_2=180 (остальные параметры не задаем – 

по умолчанию их значения равны 0). 

 
Рис. 3.3. Поперечное сечение извитого сосуда 
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Протянем получившийся полукруг вдоль построенного сплайна 

Preprocessor->Modeling->Operate->Extrude->Areas->Along Lines. Выбираем 

протягиваемую поверхность (полукруг), подтверждаем выбор средней кнопкой 

мыши или кнопкой Apply в окне в левом нижнем углу, затем выбираем кривую, 

вдоль которой будем протягивать полукруг (рис. 3.4).  

 
Рис. 3.4. 3D модель извитого сосуда 
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4. СОЗДАНИЕ ВЫЧИСЛИТЕЛЬНОЙ СЕТКИ 

 

При решении краевых задач методом конечных элементов важно 

построить качественную регулярную (структурированную) четырехугольную, а 

в пространственном случае гексаэдрическую вычислительную сетку, если это 

позволяет геометрия модели. Такая сетка создается потому что, во-первых, она 

содержит как минимум вдвое меньше элементов, чем аналогичная треугольная 

(тетраэдрическая), что уменьшает время разбиения и решения задачи в разы, а, 

во-вторых, в некоторых случаях улучшает сходимость задачи.  

Построение регулярных вычислительных сеток во многих случаях 

является нетривиальной задачей, что объясняется сложностью геометрии.  

ANSYS Mechanical APDL позволяет создавать плоские регулярные сетки 

на регулярных поверхностях, то есть поверхностях, ограниченных 3 или 4 

линиями. В случае, если поверхность ограничена более, чем 4 линиями, 

существует возможность выбора углов поверхности для создания такой сетки. 

Рассмотрим следующую геометрию (рис. 4.1) и попытаемся создать на 

ней регулярную четырехугольную вычислительную сетку. 

 
Рис. 4.1. 2D геометрия 
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Перед тем, как создавать вычислительную сетку, 

требуется выбрать элемент (выбор элемента означает 

выбор уравнений, описывающих моделируемый 

процесс, то есть уравнений, которые будут решаться 

программой в той области, которую этим элементом 

разбивают).  

Мы будем использовать элементы Flotran, 

которые моделируют уравнения Навье-Стокса, 

описывающие течение вязких жидкостей (например, 

вода, кровь). Выбор элементов производится в меню 

Preprocessor->Element type-> Add/Edit/Delete->Add-

>Flotran CFD->2D Flotran 141. Выбрав элемент, мы 

можем приступать к созданию вычислительной сетки.  

В плоском случае возможны два типа сеток: 

треугольная (элемент сетки – треугольник), 

четырехугольная (элемент сетки – четырехугольник). 

Остановимся более подробно на создании 

четырехугольной сетки.  

Перейдем в меню Preprocessor->Meshing->Meshtool. 

Окно разделено на 4 поля:  

Element Attributes (клавишей set производится выбор элемента, материала 

и некоторых других параметров); 

Size Controls (клавишами Set задаются размеры элементов и разбиение 

геометрических объектов, а клавишами Clear производится удаление 

разбиений); 

Mesh (непосредственное создание сетки – выбор объекта, на котором 

создается сетка, выбор типа элементов сетки и типа сетки); 

Refine at (поле, где задаются параметры измельчения уже созданной 

сетки). 
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Перейдем к процессу создания вычислительной сетки на выбранной 

геометрии. Из рисунка 4.1 видно, что геометрия состоит из 4 поверхностей, две 

из которых являются регулярными, а две – нет.  

Каждую из двух нерегулярных поверхностей поделим на две регулярные 

(рис. 4.2). В итоге получим 4 регулярные поверхности, на которых сможем 

построить регулярную вычислительную сетку описанным выше способом. 

Соединим левый верхний и правый нижний углы квадрата прямой линией. 

Будем использовать эту линию для разбиения нерегулярных поверхностей на 

регулярные (операция Booleans->Divide->Area by line).  

Разобьем получившиеся поверхности на сетку следующим образом: 

зададим глобальный размер элемента: Preprocessor->Meshing->Meshtool->Size 

controls->Global. 

Для этого нам потребуется вспомнить (или узнать) характерный размер 

линий, ограничивающих разбиваемые поверхности. Можем сделать это 

следующим образом List->Picked entities->Query Item->Length. 

 
Рис. 4.2. Выбор линии 

 

Далее выбираем линию, как показано на рисунке 4.2 (обычно выбирают 

самую короткую по длине линию или линию с характерным размером для 

данной геометрии). На экране появится окно с параметрами выбранной линии 

(рис. 4.3). 
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Рис. 4.3. Окно с параметрами линии 

 

Нас интересует параметр Length TOTAL, он равен 0.091599. Задаем 

размер элемента таким образом, чтобы на выбранной линии уместилось, к 

примеру, как минимум 10 элементов (в дальнейшем мы сможем улучшить 

сетку с помощью Preprocessor->Meshing->Meshtool->Refine). 

В поле Mesh выбираем Areas, Mapped, 3 or 4 sided и создаем 

вычислительную сетку на криволинейном треугольнике (рис. 4.4).  

 
Рис. 4.4. Вычислительная сетка на криволинейном треугольнике 

 

Далее в поле Mesh выбираем Areas, Quad, Mapped, pick corners, нажимаем 

кнопку Mesh и выбираем последовательно поверхности (самостоятельно 

указывая программе углы криволинейных четырехугольников) и получаем 

вычислительную сетку, представленную на рисунке 4.5.  
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Рис. 4.5. Плоская регулярная вычислительная сетка 

 

Важно отметить порядок разбиения поверхностей. Следует сначала 

разбивать криволинейный треугольник, а затем в направлении по часовой или 

против часовой стрелки криволинейные четырехугольники. Это следует делать 

потому, что если сначала разбить криволинейные четырехугольники, а только 

потом перейти к разбиению треугольника, число элементов на боковых 

сторонах треугольника не совпадет и тогда создание регулярной 

вычислительной сетки будет невозможно.  

 

Задания для самостоятельной работы 

 

1. Построить регулярную четырехугольную вычислительную сетку для 

моделей расширяющихся каналов и треугольника с вырезанным 

четырехугольником, созданных ранее. Перед построением вычислительной 

сетки требуется объединить одинаковые геометрические объекты, которые 

могут появиться при создании модели. Объединение производится командой 

Preprocessor->Numbering Ctrls->Merge items (задать параметр Type of item to be 

merge = All). 

Использовать элемент Flotran CFD->Flotran141, размер элемента 

задавать так же, как и в рассмотренном выше примере. В случае треугольника 

следует разбить поверхность на несколько регулярных с помощью опции 
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деления поверхности линией. Для создания нужных линий требуется поместить 

на стороны треугольника точки с помощью инструмента Create->Keypoints-

>On line и указать положение точки на линии мышью. Альтернативный способ 

Create->Keypoints->On line w/ratio (здесь указывается положение точки на 

линии в долях единицы, где 0 – начало линии, 1 – конец линии).  
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5. СОЗДАНИЕ ТРЕХМЕРНОЙ РЕГУЛЯРНОЙ 

ГЕКСАЭДРИЧЕСКОЙ ВЫЧИСЛИТЕЛЬНОЙ СЕТКИ 

 

Создание таких сеток возможно с помощью инструмента протягивания 

вдоль образующей линии трехмерного объекта, а также с помощью кручения. В 

первом случае сначала создается сетка на поперечном сечении объекта, а затем 

она протягивается вдоль образующей. Во втором случае сетка создается на 

сечении объекта, которое потом прокручивается вокруг оси. Подробнее 

рассмотрим первый случай. Построим вычислительную сетку на 3D модели 

артерии, созданной ранее.  

Сначала разобьем построенную модель на две части вдоль осевой линии. 

Это делается для того, чтобы создать регулярную четырехугольную сетку на 

торцевом сечении трехмерного объекта. Для этого на торцевой поверхности 

создадим прямую, делящую поверхность на две равные части. Ставим точку на 

криволинейной границе поверхности Preprocessor->Modeling->Create-

>Keypoints->Keypoint on line w/Ratio, в поле Ratio задаем значение 0.5. Далее 

строим прямую через только что созданную точку и точку на середине 

диаметра. Затем протягиваем созданную прямую вдоль сплайна, лежащего в 

основании объекта: Preprocessor->Modeling->Operate->Extrude->Line along 

line. Делим получившейся поверхностью трехмерный объект пополам 

(Preprocessor->Modeling->Operate->Booleans->Divide->Volume by area). В 

свойствах plot ctrls->numbering изменим параметры отображения объектов для 

выделения каждого объема своим цветом (рис. 5.1). 

Для создания вычислительной сетки на торце артерии будем 

использовать элемент Mesh200, который является чисто геометрическим 

элементом, то есть в процессе расчета не участвует. 
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Рис. 5.1. Подсветка объемов разными цветами 

 

Добавляем элемент Mesh200 Element type->Add->Not solved->Mesh200. В 

свойствах элемента указываем его тип Element shape->Quad 4 node 

(четырехугольный четырехузловой элемент). Разбиваем торец этим элементом 

Preprocessor->Meshing->Meshtool->Element attributes->Set->Element type 

number->Mesh 200. Зададим размер элемента Meshtool->Size controls->Global-

>Set->Element edge length=0.0005 м. Далее meshtool->Mesh->Areas->Quad-

>Mapped->3 or 4 sided и разбиваем торец вычислительной сеткой (рис. 5.2). 

 
Рис. 5.2. Торец с вычислительной сеткой 

 

Добавим из библиотеки элементов трехмерный элемент Flotran142.  
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Для протягивания созданной на торце вычислительной сетки вдоль 

модели требуется разбить образующие линии на отрезки (то есть мы задаем 

размер или количество элементов сетки по длине модели). Делаем это 

следующим образом. Meshtool->Size contrls->Line->Set выбираем линии и в 

поле No of element divisions задаем количество разбиений 100. Выбираем 

трехмерный элемент Preprocessor->Meshing->Meshtool->Element attributes-

>Set->Element type number->Flotran 142. Переходим к процессу протягивания 

вычислительной сетки. Mеshtool->Mesh->Volumes->Hex->Sweep выбираем два 

имеющихся объема, подтверждаем выбор средней кнопкой мыши и создаем 

сетку (рис. 5.3). 

 
Рис. 5.3. Трехмерная гексаэдрическая вычислительная сетка 

 

Для того, чтобы быть уверенными в том, что ни один из объектов 

получившийся модели не является двойным, объединим возможные двойные 

объекты: Preprocessor->Numbering ctrls->Merge items-> в поле Item to be merge 

выбираем All, далее параметр Tolerance задаем 1E-8. 

 

Задание для самостоятельной работы 

 

1. Построить следующую вычислительную сетку (при построении 

геометрической модели использовать метод Modeling->Operate->Extrude-

>Area->Area About Axis, ось вращения задавать точками, кривую линию 
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создавать сплайном, поверхность – по линиям ее ограничивающим, координаты 

точек указаны на рисунке). 
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6. РЕШЕНИЕ ЗАДАЧИ О СТАЦИОНАРНОМ ТЕЧЕНИИ 

ЖИДКОСТИ В РАСШИРЯЮЩЕМСЯ КАНАЛЕ 

 

Постановка задачи 

 

Рассмотрим модели каналов, построенные ранее, будем использовать 

построенную ранее регулярную вычислительную сетку. Так как сетка уже 

создана, то это означает, что выбран элемент, то есть решаемые уравнения – 

уравнения Навье-Стокса. Следовательно, для постановки задачи требуется 

задать свойства материала – однородной ньютоновской несжимаемой 

жидкости, а также поставить граничные условия – приложить нагрузки на 

входе и выходе из канала и задать условия прилипания на стенках канала. 

Начальные условия в стационарном случае отсутствуют.  

Также требуется настроить параметры моделирования – течение 

стационарное, адиабатическое, ламинарное Preprocessor->Flotran Set-up-

>Solution Options. Выбранные параметры отражены на рисунке 6.1. 

 
Рис. 6.1. Параметры моделирования 
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Настроим параметры решателя – зададим количество итераций, критерии 

точности для искомых величин, а также параметры вывода на экран и записи в 

файл результатов расчета (рис. 6.2). 

 
Рис. 6.2. Параметры решателя 

 

Preprocessor->Flotran Set-up->Solution Options->Execution control: 

количество итераций (exec global iterations) 50, частота перезаписи результатов 

в выходной файл (over freq) 1, частота добавления результатов в выходной файл 

(append freq) 1, частота вывода результатов на экран (sumf output summary 

frequency) 1. С такими параметрами ANSYS за каждый запуск на счет будет 
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просчитывать 50 итераций, статистика по каждой из которых будет выведена на 

экран, а результат в выходной файл с расширением rfl. Значения параметров 

Termination criteria оставляем по умолчанию. Далее задаем свойства жидкости в 

решателе FLOTRAN: Preprocessor->Flotran Set-up->Fluid properties 

density=1000, viscosity=0.004. 

Граничные условия задаются следующим образом  

а) условия прилипания на границах и скорость входного потока 

Preprocessor->Loads->Define loads->Apply->Fluid/CFD->Velocity->On Lines 

выбираем линии, ограничивающие область течения жидкости, кроме входного 

и выходного сечений и задаем значения vx=0, vy=0. Аналогичным образом 

задаем скорость жидкости на входе в канал vx=0.1, vy=0; 

б) на выходе из канала задаем нулевое давление Preprocessor->Loads-

>Define loads->Apply->Fluid/CFD->Pressure DOF->On Lines, р=0.  

Так как граничные условия–нагрузки прилагались к линиям, то для 

отображения нагрузок выведем на экран линии, из которых состоит модель 

(Plot->lines). Заданные скорости на границе обозначаются красной стрелкой 

(направление стрелки совпадает с направлением соответствующей компоненты 

скорости), а давление – желтым треугольником (рис. 6.3). 

 
Рис. 6.3. Отображение граничных условий 
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Осталось запустить задачу на счет Solution->Run Flotran. Для достижения 

высокой точности результатов нужно будет просчитать как минимум 150-200 

итераций, поэтому после окончания счета 50 итераций запускаем модель на 

счет еще 2-3 раза. 

 

Просмотр результатов расчета 

 

Просмотр и работа с результатами расчета осуществляется с помощью 

меню General Postproc. Сначала требуется выбрать файл результатов с 

расширением «.rfl»: General Postproc->Data and file opts (в данном случае файл 

с результатами всего один и он загружается программой автоматически). 

Информацию о количестве данных в загруженном файле результатов можно 

узнать с помощью General Postproc->Results summary. Выбрать нужную 

итерацию для отображения или нужный шаг по времени можно с помощью 

команды General Postproc->Read results (будем выбирать последнюю итерацию 

last set).  

Отобразить результаты на экране можно с помощью меню General 

Postproc->Plot results. Здесь на выбор предлагается несколько типов 

отображения результатов Contour plot (отображение значений выбранной 

переменной цветом на геометрии модели, подходит как для векторных, так и 

для скалярных величин), Vector plot (отображение векторов выбранной 

переменной, подходит для векторных величин), Flow trace (отображение линий 

тока).  

Отобразим поле скоростей потока жидкости General Postproc->Plot 

results-> Contour plot->Nodal solution->DOF solution->Fluid velocity (рис. 6.4).  
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Рис. 6.4. Поле скоростей потока жидкости 

 

Отобразим вектора скорости General Postproc->Plot results->Vector plot-

>Predefined->DOF solution->Velocity (рис. 6.5). 

 
Рис. 6.5. Вектора скорости 

 

Выведем на экран линии тока. Для этого требуется поставить несколько 

точек на геометрии модели, через которые будут проходить линии тока. Для 

возможности нанесения точек изменим настройки рабочей плоскости 
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Workplane->WP settings->Snap incr = 0.0005. Это сделано для того, чтобы задать 

минимальное расстояние между наносимыми точками (по умолчанию оно 

равно 0.05, что является недостаточным, так как размер входного сечения равен 

0.01). 

Далее General postproc->Plot results->Define trace Pt наносим несколько 

точек в районе входного сечения в канал и несколько точек в районе 

расширения канала так, как показано на рисунке 6.6 (всего можно нанести не 

более 50 точек). 

 
Рис. 6.6. Установка точек для создания линий тока 

 

Через нанесенные точки отрисуем линии тока General postproc->Plot 

results->Plot flow trace->DOF solution->VSUM (рис. 6.7). 

 
Рис. 6.7. Линии тока 
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По готовым линиям тока можно создать анимацию движения частиц 

жидкости PLotCtrls->Animate->Particle flow. В настройках выбираем DOF 

solution, VSUM. Остальные параметры оставляем заданными по умолчанию. 

Получаем рисунок 6.8. Прямоугольник на линии тока определяет движущуюся 

частицу, а его длина – скорость частицы 

 
Рис. 6.8. Линии тока с виртуальными частицами жидкости 

 

Приведем график изменения скорости тока в выходном сечении канала 

(рис. 6.9). Для этого требуется воспользоваться пунктом меню General postproc-

>Path operations. Сначала создаем маршрут, по которому будем исследовать 

изменение скорости General postproc->Path operations->Define path->By nodes 

и выбираем узлы – начало и конец отрезка-выхода из канала. Далее с помощью 

команды General postproc->Path operations->Plot paths можем отрисовать 

созданный маршрут на геометрии модели. Затем помещаем на маршрут 

исследуемую величину – скорость потока General postproc->Path operations-

>Map onto path->DOF solution->VSUM и отображаем изменение скорости в 

виде графика General postproc->Path operations->Plot path item->On graph-

>VSUM. 
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Рис. 6.9. Профиль скорости на выходе из канала 

 

Из построенного графика видно, что профиль скорости на выходе из 

канала не является параболическим, причем пик скорости смещен к нижней 

границе канала. В следующем примере предлагается самостоятельно провести 

моделирование стационарного потока в удлиненном канале, более протяженная 

геометрия которого позволит получить параболический профиль скорости на 

выходе из канала.  

 

Задание для самостоятельной работы 

 

1. Провести моделирование стационарного течения жидкости в 

расширяющемся канале длиной 30 см, построенном ранее. Сравнить 

полученные результаты с результатами примера, разобранного выше. 
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7. РЕШЕНИЕ ЗАДАЧИ О НЕСТАЦИОНАРНОМ ТЕЧЕНИИ 

ЖИДКОСТИ В РАСШИРЯЮЩЕМСЯ КАНАЛЕ 
 

Постановка задачи 

 

Для решения нестационарной задачи достаточно использовать созданный 

ранее файл со стационарной постановкой задачи, следует только изменить 

настройки решателя Preprocessor->Flotran Setup->Solution options->Transient, 

Preprocessor->Flotran Setup->Execution ctrl (рис. 7.1). 

 
Рис. 7.1. Изменения настройки решателя 

 

Задаем параметры: размер шага по времени и количество шагов, также 

время окончания приложения нагрузки user defined time step = 0.05, number of 

time steps = 40, End time for ramp BC = 2 (рис. 7.2). 

Далее изменяем имя задачи File->Change Jobname-> добавляем к 

имеющемуся имени Transient, а также ставим галочку New log and error files 

для того, чтобы результаты моделирования предыдущей стационарной задачи 

не пропали. 

Запускаем задачу на счет либо командой Solution->Solve->Current LS, 

либо командой Solution->Run flotran. 

Для отображения результатов аналогичным образом выбираем нужный 

шаг по времени, отображаем скорости потока, давление и линии тока, а также 

траектории движения частиц. Так как задача нестационарная, то можно создать 

анимацию движения потока жидкости. Для этого зададим параметры анимации 

в соответствии в рисунком PlotCtrls->Animate->Over results (рис. 7.3).  
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Рис. 7.2. Окно задания параметров решателя 
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Рис. 7.3. Окно задания параметров анимации 

 

Задание для самостоятельной работы 

 

1. Решить задачу о нестационарном течении крови через построенную 

ранее извитую артерию в трехмерном случае. Скорость на входе в артерию 

задавать такую же, как и в предыдущих задачах. В трехмерной постановке 

отличия от двумерного случая будут лишь в добавлении третьей компоненты 

скорости по оси Oz, а также в необходимости постановки граничных условий 

симметрии потока на нижней границе, которые заключаются в равенстве 

нормальной компоненты скорости потока нулю на этой границе. 
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8. РЕШЕНИЕ ЗАДАЧИ О ПРИЛОЖЕНИИ ДАВЛЕНИЯ К 

ВНУТРЕННЕЙ ПОВЕРХНОСТИ ЛЕВОГО ЖЕЛУДОЧКА 

СЕРДЦА 

 

Создание трехмерной геометрии модели левого желудочка (ЛЖ) сердца 

[5, 8, 9] было проведено в системе автоматизированного проектирования 

SolidWorks [10]. Для ее анализа был проведен импорт трехмерной 

геометрической модели в Ansys: File->Import->Parasolid. На экране 

отображается совокупность геометрических объектов, для преобразования их в 

объем: PlotCtrls->Reset Plot Ctrls-> нажимаем правой кнопкой мыши на экран 

Replot. На экране отразился объем соответствующий объему стенки ЛЖ. 

На модель была наложена нерегулярная тетраэдрическая расчетная сетка 

с размером ребра ячейки 0,0025м, тип элементов solid 187. Данный элемент 

является 10 узловым, имеющим в каждом узле три степени свободы. В итоге 

модель была разбита на 75 000 элементов (рис. 8.1). 

    
Рис. 8.1. Вычислительная нерегулярная тетраэдрическая сетка на модели ЛЖ 

 

Так как сетка уже создана, то это означает, что выбран элемент, то есть 

решаемые уравнения – уравнения Навье-Ламе. Следовательно, для постановки 

задачи требуется задать свойства материала, он нами предполагался как 

линейный изотропный, а также поставить граничные условия.  

Свойства материала задаются следующим образом: 

Preprocessor->Material Models-> далее всплывает таблица (рис. 8.2) в 

которой мы выбираем интересующий нас материал и задаем соответствующие 

ему характеристики (рис. 8.3). 
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Рис. 8.2. Создание нового материала 

 

 

Рис. 8.3. Присвоение материалу соответствующих характеристик 

 

Граничные условия задаются следующим образом: 

а) предполагалось, что узлы, принадлежащие элементам зоны клапанного 

аппарата, жестко закреплены, т.е. наложено ограничение по степеням свободы 

UX=0, UY=0, UZ=0 (рис 8.4):  

Preprocessor-> Loads->Define loads->Apply->Structural->Displacement->On 

Nodes-> выбираем соответствующие узлы-> All DOF ; 
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Рис. 8.4. Жесткое закрепление зоны клапанного аппарата 

 

б) на внутреннюю поверхность ЛЖ было приложено давление и учтено 

воздействие давления со стороны правого желудочка на зону межжелудочковой 

перегородки (рис. 8.5) : 

Preprocessor-> Loads->Define loads->Apply->Structural->Pressure->On Areas-> 

выбираем соответствующие поверхности и задаем значения давления. 

    

Рис. 8.5. Приложение давления на соответствующие поверхности ЛЖ 

 

Начальные условия в стационарном случае отсутствуют.  

Настроим параметры решателя: Solution->Sol’n Controls (рис. 8.6). 
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Рис. 8.6. Настройка решателя 

 

Осталось запустить задачу на счет Solution->Solve->Current LS.  

 

Просмотр результатов расчета 

 

Просмотр и работа с результатами расчета осуществляются с помощью 

меню General Postproc. Сначала требуется выбрать файл результатов с 

расширением .rst: General Postproc->Data and file opts (в данном случае файл с 

результатами всего один и он загружается программой автоматически). 

Информацию о количестве данных в загруженном файле результатов можно 

узнать с помощью General Postproc->Results summary. Выбрать нужную 

итерацию для отображения или нужный шаг по времени можно с помощью 

команды General Postproc->Read results (будем выбирать последнюю итерацию 

last set).  

Отобразить результаты на экране можно с помощью меню General 

Postproc->Plot results. Здесь на выбор предлагается несколько типов 

отображения результатов Contour plot (отображение значений выбранной 
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переменной цветом на геометрии модели, подходит как для векторных, так и 

для скалярных величин).  

Отобразим распределение значений модуля вектора перемещения стенки 

ЛЖ (рис. 8.7) General Postproc->Plot results-> Contour plot->Nodal solution-

>DOF solution->Displacement vector sum.  

 

Рис. 8.7. Распределение значений модуля вектора перемещения стенки ЛЖ  
 

Отобразим распределение значений эквивалентных напряжений для 

модели ЛЖ вектора скорости (рис. 8.8) General Postproc->Plot results-> Contour 

plot->Nodal solution->DOF solution->von Mises stress. 

 

Рис. 8.8. Распределение значений эквивалентных напряжений для модели ЛЖ 
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ЗАКЛЮЧЕНИЕ 
 

В пособии кратко изложены принципы метода конченых элементов. 

Описан интерфейс программы ANSYS Mechanical APDL. Разобраны простые 

примеры построения плоских и трехмерных объектов с помощью встроенного в 

ANSYS Mechanical APDL редактора. Рассмотрены вопросы построения 

регулярной плоской и трехмерной вычислительной сеток. Разобраны примеры 

решения некоторых краевых задач, моделирующих движение крови по плоским 

и трехмерным каналам, разобрана задача о моделировании левого желудочка 

сердца человека. 

Пособие является первым в цикле учебно-методических изданий, 

посвященных применения МКЭ в биомеханике и механике сплошной среды. 

Пособие будет полезно не только студентам, бакалаврам, аспирантам, 

магистрам, обучающимся по направлениям «механика и математическое 

моделирование» и «биомеханика», но и всем, кто интересуется численными 

расчетами применительно к задачам биомеханики, теории упругости и др. 
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